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   Training Notes 
Form / Bank Request List 1 September 2015  

The Request List determines the Bank Account and PrintBoss Form used when printing.  This is only necessary for 

accounting software that does not use a trigger or text capture file.  (A Request List is NOT used with Accpac for 

Windows). 

PrintBoss scans the list of entries in the Request List for an automatic match of predefined characteristics against the 

contents of each print job.  For example, a particular word appearing at a defined location on the page might be 

enough to identify the document. 

If one record matches, PrintBoss uses the form and bank identified in the Request List record.  If more than one 

record matches, PrintBoss provides a list of all the matches to allow the user to choose from the entries.  When no 

match occurs, PrintBoss generates an Unrecognized Doc Alert, a default Form and Bank, or a pop up containing the 

entire Request List, depending on how the Request List is setup.   

This is a very powerful tool that automates your work flow and avoids erroneous selections from the list of forms or 

banks.  Set up requires a good understanding of the data provided by your accounting software. 

SETUP 

Request List entries are automatically imported for the standard Host Accounting Software selected during the 

installation of PrintBoss.  Editing the Request List is only necessary for custom interfaces or forms you create. 

1. Open the PrintBoss Master Application. 

2. Click on the Options menu and select Form / Bank Request List.  The Form / Bank Request List 

Manager opens. 



 

NOTE: 

This feature is not available with PrintBoss Select. 

3. Import Existing Request List File 
a. Click the Import button to import an updated request list record.  These are stored by specific 

accounting software in the ReqList folder of the PrntBoss Home directory.  Only accounting 

software chosen during installation or setup will appear in this list. 

b. Select the appropriate *.prq file and click Open.  The new record will appear at the bottom of the 

list. 

4. New / Edit – It is easier to create a new or edit an existing Request List record from the Work File.  Please 

see Implementing Request List from the Work File later in this chapter. 

5. Click Done to save your changes. 

CONFIGURATION 

Your Configuration and PrintBoss Driver Settings may need to be changed to use the Request List. 

1. Open the PrintBoss Master Application. 

2. Click on the Options menu and select PrintBoss Driver Settings. 

3. Select Always Capture in the Capture Mode section. 

4. Click OK to save your changes. 

5. Click on the Options menu and select Configuration.   

6. Check the Request List determines Form/Bank field in the Always Capture Settings section in the 

bottom left corner.  This will gray out the Form and Bank choices.   

7. Select the "PB#INFO" flag overrides above check box. 

8. Click OK to save your changes. 

IMPLEMENTING REQUEST LIST FROM THE WORK FILE 

Auto Pick reviews documents printed through PrintBoss for specific traits.  When these traits match conditions in a 

record in the Request List, PrintBoss processes the document with the form and bank specified in the Request List 

record.  The entire Request List pops up when no matches are found.  The Request List also pops up when more 

than one match is found, BUT it will only include records that match. 

1. Print a document from the accounting software and select the appropriate Request List record or Form File 

so the document Work File can be examined.   

a. Verify the Auto-Archiving feature in the Form Editor is set to None or Overwrite Work File at 

Start of Batch before printing to ensure the document stays in the work file for viewing. 



2. Click on the File menu and select Open Document Work Files from the PrintBoss Master Application.   

3. Select the appropriate Work File and click Browse. 

4. Select a current record in the list and click View. 

5. Right click anywhere on the View form and select View Raw Capture.  The view will change to show 

only the data passed from the accounting software minus the PrintBoss formatting. 

6. Right click again and select View Request List Capture Groups.  The Form / Bank Request List Manager 

opens. 

7. Stretch and move both the View and the Request List Manager to see both screens as much as possible. 

8. Determine if there is an existing entry that matches you r data. 

a. Click the Test For Matches button on the Request List Manager to test if there are any existing 

entries that match.  Otherwise … 

b. Select the Request List record desired or add a new record.   

9. New/Edit Record 

a. Click on the plus  button to add a new blank record in the list.  Otherwise, select an existing 

record. 

b. Click the Edit button while the record is selected.  The Request List Editor opens. 

 

10. New Record 
a. Check Active in the top left corner of the window.  The fields are now available to edit. 

b. Prompt – Enter a word or phrase users will recognize as the form and bank combination. 

i. AP is often used to designate accounts payable activities. 

ii. PR is often used to designate payroll activities 

c. Form – Choose the appropriate PrintBoss Form from the drop down menu.  If you need to create a 

custom form, exit the Request List Editor, create the new form, then return to this window and 

continue. 

d. Bank – Choose the appropriate BankCode from the drop down menu. 

i. If you need to create a new Bank record, exit the Request List Editor, create the new 

Bank record, then return to this window and continue. 



ii. {ChkAcct}:{CompName} – Choose this entry when the accounting software passes the 

checking account name and company name.  QuickBooks has this capability. 

iii. {DocBank} – Choose DocBank when the accounting software only passes one set of data 

to identify the bank record, such as checking account name or company name.  Peachtree 

has this capability. 

iv. {None} – Choose None when the form is not a check (e.g. Invoice). 

v. {Request} – Choose Request when you would like PrintBoss to provide a list of all Bank 

Records and allow you to choose from the list. 

e. Notes – Enter notes to describe the purpose of this Request List entry, record special conditions, 

or log changes.  This is an optional field.  Click on the top or bottom edge of the Request List 

Editor dialog and drag to expand the Notes field. 

11. New/Edit Record 
a. Check Auto Pick Enabled to define conditions. PrintBoss will automatically select this Request 

List record when the conditions are met during printing and this box is checked. 

i. Review existing Request List records for samples on how to setup conditions. 

ii. You may skip this step and the Conditions if you prefer to choose from a list instead of 

using automatic selection. 

b. Conditions 
i. Check Condition 1 to activate it. 

 

1. Left and Right Rectangles – Click on the rectangle button to enclose two or 

more conditions in parentheses.   You will need to select a Right Rectangle at 

some point as well. 

a. Click once for a single parenthesis. 

b. Click twice for double parentheses. 

c. A third click will remove the parentheses. 

2. Not – Click on the short rectangle to the left of the Text field to reverse the 

condition. 

3. Operator – Select a statement about the captured field from the drop down 

menu to determine how PrintBoss reads the condition.  Fld is an abbreviation for 

Field.  The most common choices are: 

a. Fld and Text Exactly Equal 

b. Fld Begins with Text 

c. Text Within Captured Fld 

d. Field Not Empty 

4. Text – Enter the specific text PrintBoss will find at the specified coordinates.  

This field is only available when you choose an operator that uses text. 

5. Comment – Enter a note to help identify this condition.  This field is optional. 

6. Field Capture Coord. 
a. X – Enter the horizontal coordinate for the left side the field. 

i. Review the Raw Data on the document.  Look for data or parts 

of data that will ALWAYS appear on this document (e.g. a 

specific word such as Invoice, or a check number, or a dollar 

amount beginning with asterisks). 

ii. Click on the data element to give it focus.  Return to the 

Request List Editor. 

iii. Hold down the Ctrl key and click in the X field.  PrintBoss 

will automatically enter the coordinates of the selected data. 

NOTE: 

The Ctrl and click feature is only available in PrintBoss versions 5.21.9 and above. 

b. +/- ; to  button – This is a toggle button used to set a range for 

the coordinate. 



i.  – Enter a range value in the field.  A value of 0.100 will 

cause PrintBoss to look 0.100 inches before the X value and 

0.100 inches after the X value to find the data in the 

specified area. 

ii.  – Enter an end value for the range.  PrintBoss will look 

from the X value to this value to find the data in the 

specified area. 

c. Y – Enter the vertical coordinate for the top of the field.  This works 

exactly like the X coordinate.  You can Ctrl + Click on both the X and 

Y coordinates while a field is highlighted on the View. 

7. Trim – Trim the field to remove blank spaces.   The choices are: 

a. No Trim (default) 

b. Left Trim Field 

c. Right Trim Field 

d. All Trim Field (trims both the left and right side) 

8. Occurrence – Select the occurrence of the text within the specified area.  Some 

data, such as asterisks, may appear more than once.  The choices are: 

a. 1st Occurrence (default) – evaluates to the first occurrence within the 

coordinates and stops.  PrintBoss will not examine the rest of the string. 

b. All Occurrences – evaluates the entire string for a match. 

c. Append Occurrences – concatenates all the fields before evaluating the 

string for a match. 

9. Substr Start – Choose a starting point for the occurrence in the string.  

Normally this is left at the default value of zero, representing the beginning of 

the range.  You may enter a different value.  For example, PrintBoss will start 

evaluating at the 5th character when a 5 is entered in this field. 

10. Len – Enter a length for the substring to set a shorter end point for evaluating 

the string.  This field is only available when a value is entered in Subst Start.  

PrintBoss will evaluate the remainder of the string from the start of the substring 

when a value of zero is entered. 

ii. Check Condition 2 to activate it. 

iii. An And button will appear between the two conditions.  This indicates the next condition 

must ALSO be true for a match.  Click the button to change to OR for either condition to 

be true to constitute a match. 

1. Single parentheses are often added at the beginning of one condition and the end 

of the second when OR is selected in between. 

iv. Continue filling in the fields for Condition 2.   

1. The rules are the same for all 4 Conditions. 

2. You only need to setup more than two conditions when two is not enough to 

make this entry unique or you have a special condition. 

c. Click the Test Document Being Viewed button at the bottom of the Request List Editor to test 

whether the Request List record matches the open Form File.   

d. Make adjustments as necessary until you receive the ReqList Record MATCHES!!! message. 

e. Click OK on the Request List Editor when you have a successful match. 

f. Click the Test for Matches button at the top of the Form / Bank Request List Manager window to 

test the number of entries that match the open Form File.  

i. You should only have 1 match.   

ii. If there is more than one match, change or add a condition to the current Form / Bank 

Request List record to make it unique. 

12. Click DONE on the Form / Bank Request list Manager when you are finished and Close the View. 

Repeat as often as necessary to create a list of all required form and bank account combinations.  DO NOT create 

more than one entry for the same Form File.  The Notes field can be used to track updates to the record. 

There are four conditions you can use to make a Request List record unique.  It is very important to make each 

request list entry as unique as possible to avoid multiple matches when Auto Pick is enabled.   

� It is very important to make each Request List entry as unique as possible to avoid multiple matches 

when Auto Pick is enabled. 



REQUEST LIST PROCESS 

Click Done once all of the Request List records are complete.  The next time a document is printed through 

PrintBoss, PrintBoss will evaluate the document for matches to the defined conditions and automatically select the 

appropriate Form and Bank combination to process the file. 

PrintBoss may open the Bank List to choose a bank the first time you print using that account.  This happens when 

the Bank Code does not exactly match the information from the accounting software.  A check box at the bottom of 

the popup list will update the Bank Code to match the data passed from the accounting software.  This allows 

PrintBoss to automatically pick the correct Bank Record the next time you print to that account.  

 



 


